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Preface

IBM® Systems Solution for Branch Banking is targeted to the financial institutions that have 
chosen to keep a decentralized infrastructure. This is approximately 50% of the customer 
base. This solution is technology-rich, and will therefore be most attractive to those banks 
who plan to have a technology refresh—that is, those who have not done a major upgrade of 
their branch infrastructure for the past 5 to 10 years. 

Systems Solution for Branch Banking is a hardware and software solution that enables banks 
to provide a common, easy-to-support IT infrastructure in their branch locations. The solution 
takes into consideration that the skills required to upgrade or maintain the infrastructure in the 
branch do not exist, so we provide a remote management function. Although a common 
solution has been defined, each implementation may have its own unique variations, 
depending on the network, software, and hardware environments. 

This IBM Redbook discusses how to install and configure the components of the Systems 
Solution for Branch Banking. 

Your feedback is welcome. Send an e-mail to: csi@us.ibm.com
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engineering and IT experience. Prior to working at IBM, Ira worked at Digital Equipment 
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George Dillard is a PMI certified project manager in the Center for Solution Integration. He 
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engagements, leveraging IBM STG technologies to solve customer business problems. Prior 
to that he spent 16 years in z/OS® solution and performance test as a technical team leader, 
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subsystems performance.
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Chapter 1. Introduction

IBM Systems Solution for Branch Banking is a hardware and software solution that enables 
banks to provide a common, easy-to-support IT infrastructure in their branch locations. The 
solution takes into consideration that the skills required to upgrade or maintain the 
infrastructure in the branch do not exist, so we provide a remote management function. 
Although a common solution has been defined, each implementation may have its own 
unique variations depending on the network, software, and hardware environments. 

1
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1.1  Industry overview

The retail banking industry is looking to leverage on demand technologies to integrate all of a 
customer’s interactions with the bank to expand and enrich the customer relationship. This 
initiative is driving a shift in the view of business conducted by the customer at the branch 
from the traditional focus on financial transactions to one that looks more like retail sales. This 
increased focus on the customer is also driving a shift in the focus in the selection of 
Information Technology (IT) infrastructures from the traditional attributes such as function and 
price to include non-functional requirements such as flexibility, security, and low-cost 
maintenance.

The infrastructure that supports this new view must be flexible enough to include new devices 
such as video kiosks and assisted teller machines in addition to traditional banking equipment 
and IT applications. It must be secure and it must be able to be managed and operated from 
a remote site, because having IT skills at the local branch is impractical. 

Although a fully centralized database is necessary for many banking applications, several 
requirements call for IT assets to be located at the branch.

Examples of these are:

� The use of large digital video files, which increases the need for local caching.

� Automation of application maintenance, which drives the need for local file staging, 
enabling clients to update at convenient times and conserving network bandwidth at the 
central site.

� The need for offline processing (that is, continuing to operate without connectivity to the 
central site), which means that a certain level of processing and storage capabilities must 
remain at the branch.

Additional factors that drive increased investment in branch bank IT infrastructure include:

� Replacing obsolete technology in the branch that hampers achievement of branch sales 
and servicing objectives.

� Upgrading the branch network infrastructure to enable browser-based environments.

� CRM-enabling the teller to empower branch staff to sell and service.

� Process streamlining and re-engineering to ensure greater automation, efficiency, and 
customer service.

� Increasing self-service capabilities in the branch.

� In the short term, driving legacy systems out of the branch will be the single most 
important technology driver. A survey of 50 U.S. banks found that technology 
obsolescence was the key driver for 27% of banks, and moving to a browser-based 
environment was the key driver for 31%.

In this book, we focus on the bank branch infrastructure consolidation due to renewed branch 
importance. It has been seen that the branches have received minimum upgrade 
investments. There are desktops and servers all over the branch, and not many people in the 
branch are technical enough to make changes or upgrades to the software or hardware. The 
customer expectation at the branch has increased and the business processes are inefficient 
and ineffective. The technology solutions are obsolete. The banks have acknowledged that 
branches are a key ingredient to success with their multi-channel efforts and are refocusing 
attention and investments in their branch networks.
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1.2  Solution architecture overview

The Systems Solution for Branch Banking infrastructure provides:

� Flexibility: New components can be added with little or no disruption to the existing 
environment and new technology can be easily accommodated.

� Rich security: Outside accessibility to the system is minimized down to the individual teller 
workstations, and security mechanisms such as automated virus definition updates are 
easily implemented.

� Easy maintenance: The infrastructure can be fully monitored and maintained from a 
remote location, including installations requiring client reboots.

Systems Solution for Branch Banking is targeted to the financial institutions that have chosen 
to keep a decentralized infrastructure. This is approximately 50% of the customer base. This 
solution is a technology sell, and therefore will be most attractive to those banks that are due 
for a technology refresh; that is, those that have not done a major upgrade of their branch 
infrastructure for the past 5 to 10 years.

Figure 1-1   Architecture components

� Branch servers provide:

– Branch file server: Contains files and databases for local use. The files may be 
application data or could be staged updates for system files.

– Local application server: Contains local applications that are accessed by client 
workstations within the branch. It may also contain a single application that runs on 
behalf of the branch, such as Video Surveillance. 
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– Hosted client server

Leverages virtualization technology to provide the capability to host multiple clients on 
a single server or blade, replacing all or most of the desktop PCs in the branch. This 
capability simplifies management of hardware, deployment of new software images, 
and maintenance by leveraging virtualization technology.

� The solution provides a robust platform for remote management by combining IBM 
Director with management software such as Tivoli® Business Systems Manager, Remote 
Deployment Manager, or other management software. Remote management provides the 
following capabilities:

– A single management module for the entire server, which includes all blades on an IBM 
BladeCenter®.

– Remote provisioning of the entire software stack from operating system to application.

– Update of application software, including software that requires a reboot of the client. 
Clients can be updated directly or update files can be staged for processing during 
non-peak hours.

– Management of individual clients: hosted clients can be individually reprovisioned 
according to business needs. 

– Managed desktop and workplaces that support different application views and access 
by user or by client type.

� Branch networking:

– Basic connectivity to a local area network is provided by an integrated switch in the 
Systems Solution for Branch Banking infrastructure. 

– Firewalls and virtual networking can be implemented via software on a server or may 
be provided directly as part of the network routing equipment.

– Expanded network services such as voice over IP (VoIP) can be integrated into the 
infrastructure as well.

� Branch applications:

– Branch banking applications themselves are not provided as part of the infrastructure. 
Stand-alone applications can be contained on a local application server. Desktop 
applications can be included in hosted client images. 

– The modular nature of Systems Solution for Branch Banking allows for the insertion of 
a new local application server with little or no disruption to the existing infrastructure.

� Pervasive security: Security is implemented at each layer of the system.

– Network security provides traditional security components such as firewalls and virtual 
networking. This capability can also be implemented through traditional network 
routing equipment. Through the use of the BladeCenter integrated switches, software 
routing, firewalls and virtual networking can be included as part of the solution, 
eliminating the need for external equipment at the branch.

– At the application level, additional layers of security are provided through the hosted 
clients and managed desktops that provide central control of individual clients and 
client applications.

– Remote application management provides the capability for automated updates of 
virus definition files.

– The optional Video Surveillance feature can assist in the physical security of the 
branch bank.
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Chapter 2. Solution details

This chapter discusses the elements of the solution, including overall architecture, hardware, 
software, and the network.

2
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2.1  Physical architecture of the solution 

Figure 2-1 shows all the major components of the solution in the overall architecture. The 
components on the left of the firewall are present in the bank branch, and the components on 
the right are located at the Central site. The branch comprises the tellers with their 
applications on the hosted clients with servers such as the staging server, file server, and the 
application server. This entire infrastructure is hosted on a BladeCenter, making the 
management of the infrastructure easy. We can enhance the solution by adding existing 
technologies such as the wireless capability and the VoIP infrastructure shown in the figure.

The Central site contains the System Management infrastructure: Provisioning, Software 
distribution, and the System Monitor. This is accomplished by the IBM Director/Altiris 
combination (one of several IBM Director and management software combinations).

Figure 2-1   Physical architecture of the solution

2.2  Solution components

This section lists the hardware and software that we included in our solution.
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2.2.1  Hardware

BladeCenter chassis and blade servers
BladeCenter is a chassis that houses the blade servers and provides a broad range of 
networking options integrated into the chassis to simplify infrastructure complexity and 
manageability while lowering total cost of ownership. The BladeCenter supports 2-way 
POWER™ processor based servers and 4-way Intel® processor based servers. The 
BladeCenter design makes them highly flexible and scalable. The blades in the BladeCenter 
are slim, hot-swappable blade servers that fit in a single chassis similar to books in a 
bookshelf. Each is an independent server, with its own processors, memory, storage, network 
controllers, operating system, and applications. The blade server simply slides into a bay in 
the chassis and plugs into a midplane or backplane, sharing power, fans, floppy drives, 
switches, and ports with other blade servers. 

The BladeCenter simplifies the task of running down hundreds of cables strung through racks 
just to add and remove servers. With switches and power units shared, precious space is 
freed up -- and blade servers enable higher density with far greater ease.

DataCom Digital Surveillance Solution
DataCom is a Digital Surveillance solution. The DataCom PCI card can be inserted into an 
HS20 BladeCenter via a PCI Expansion card. DataCom Systems uses the IBM System x or 
BladeCenter servers to integrate and centralize network security and surveillance 
applications in response to security threats (both internal and external). The server offers a 
level of stability and support due to the modular design of the BladeCenter architecture. With 
the DataCom products we can monitor real-time video using a network connection and also 
integrate analog or IP network cameras.

Hosted Client - ClearCube I/Ports and supporting hardware
For this solution ClearCube provides hosted client capabilities. It is a compact device, similar 
in size to a cable modem, which connects to virtual clients running on the BladeCenter using 
the user’s monitor, keyboard, mouse, speakers, and USB peripherals. This device uses 
standard Ethernet to connect to a centralized BladeCenter that houses the blade servers. The 
data on the blade servers is protected because the I/Port does not allow connection of a mass 
storage device. In our solution we are using the I/Port along with the supporting hardware 
(monitor, keyboard, mouse, speakers, and so forth).

VoIP Gateway and VoIP phones
VoIP is the process of transporting digitized speech in IP packets over a wide area network 
such as the Internet. The speech can be a real-time voice conversation or a non real-time 
transaction such as voice mail. A VoIP Gateway or a Soft switch or a Gatekeeper is a generic 
term for a device that handles VoIP data and signaling traffic. VoIP phones are special phones 
that can be used to access a VoIP network. VoIP phones can get the traditional dial tone when 
used with an adapter. VoIP also allows making calls directly from the computer, which can act 
as the phone. To use a VoIP network, you must have high-speed internet access such as DSL 
or cable. VoIP has some unique benefits: The technology is digital and travels over high-speed 
network so you can attach an intelligent VoIP phone or computer to the network and use it to 
create value-added customized programs as with any traditional program for a device. 

Although the deployment of VoIP is a key part of the Systems Solution for Branch Banking, 
installation details are beyond the scope of this guide. Consult your VoIP hardware 
documentation for installation details.
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2.2.2  Software

Windows Storage Server
Windows® Storage Server provides file-sharing services for storing common applications and 
images to support remote bank branches.

IBM Director
IBM Director provides out-of-band management of the BladeCenter chassis as well as 
services such as resource monitoring and software distribution to the running operating 
systems on the blades. IBM Director includes tasks to facilitate the initial discovery of new 
hardware, setup, and configuration of groups of servers, and ongoing monitoring and change 
management throughout the operational life of the hardware. 

The IBM Director product consists of three components: 

� IBM Director Server is the main daemon—or aggregation point—for discovering and 
managing resources, communicating to the console and endpoint agents, and 
authenticating and regulating access privileges. It is also the container for all of the 
task-based services and the engine for receiving events and dispatching automated 
actions. 

� IBM Director Agent runs in the operating system of the endpoint server platforms that are 
being managed. The IBM Director Server can discover and manage the operating 
systems where the IBM Director Agent is installed. The agent provides industry-standard 
instrumentation that can be integrated with the IBM Director Server or easily integrated 
into third-party systems management tools. 

� IBM Director Console provides a graphical user interface with a consistent look and feel 
for all server platforms and devices maintained by the management server. 

Altiris Deployment solution
Altiris’ Deployment solution contains two main components: the Deployment Server (DS) and 
the integration modules that are required to integrate the Deployment Server with Altiris’ 
Notification Server. 

Deployment Server provides the following functionality for Systems Solution for Branch 
Banking:

� Imaging
� Software distribution
� Support for PXE and Wake on LAN®
� Support for Windows and Linux®

Using a combination of imaging, software distribution, and PXE, it is entirely possible to 
rebuild a failed system from the ground up using Deployment Server. Continued steady state 
management is possible through the use of Deployment Server’s client software (Aclient). 
The client software enables the remote distribution of software, as well as other activities to 
targeted systems as needed.

Deployment Server activities, called “Jobs,” represent a series of tasks to be performed by the 
client system or Deployment Server. They can be built with tasks to automatically create and 
deploy hard disk images, back up and distribute software or personality settings, add printers, 
configure computer settings, and perform all aspects of IT administration.

Jobs can be run immediately against a single computer or group of computers or scheduled 
to run at a specified time. Furthermore, a repetitive schedule can be created so that 
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administrative jobs can be automated. Jobs can be linked so that the successful completion 
of one job will lead to the automatic scheduling of another job.

VMware ESX
VMware ESX server is used for virtualized infrastructure for partitioning, consolidation, and 
managing servers. It provides the ability to host multiple virtualized servers on a common 
computing platform. Hardware dependencies are isolated by VMware so that underlying 
processors, memory, storage, and adapter cards (network/storage) are available to be shared 
by each virtual machine. The number of virtual hosts each server may support is limited by 
the number and speed of processors and the amount of available disk space.

Banking Teller Application (optional)
This is the actual application that simulates the teller environment and enables us to test the 
underlying infrastructure. Refer to Appendix A, “Teller application” on page 65.

The banking teller application simulates all major functionalities of a bank branch teller. It is a 
WebSphere® Everyplace® client 6.0 that extends the J2EE™ programming model to the 
client for performance and operational resiliency. It can perform such functions as:

� Look, modify. and delete account holder details
� Create bank accounts
� Transfer money between accounts
� Deposit and withdraw money

This application can run in both online and offline modes. In offline mode the transaction data 
is stored locally and synchronized with the server as soon as the application comes online.

There are two components to this application. The server component has the server 
application deployed on WebSphere Application Server, MQ, and the database. The client is 
WebSphere Everyplace Client, which hosts the client application and makes connections to 
the server using Web services. 

2.3  Network architecture

This solution is on a flat network as shown in Figure 2-2 on page 10. All servers are hosted in 
a BladeCenter that is connected to the internal network. Network-connected components are:

� Bank branch site
– Storage server
– Test application on the hosted client

� Central site
– Systems management components
– VMware images

In a real deployment, a more complex network topology would be implemented that would 
have firewalls and VPNs to separate the central site from the branch office.
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Figure 2-2   Network architecture of the solution

Networking prerequisites:

� Installed and configured DHCP server
� DNS server (newly installed or existing)
� Other networking considerations, such as Port Fast Enabled

2.4  Hardware/software requirements

� IBM BladeCenter HS20
– WIndows 2003 Server with Service Pack 1

� Two Cisco Intelligent Ethernet Switch Modules for:
– Public Network
– Client Network

� One IBM HS20 Blade Storage Server Gateway to host
– Windows 2003 Server with Service Pack 1
– DNS
– DHCP
– IBM Director V4.22
– MS SQL Server 2000 SP4
– Symantec Antivirus
– Altiris Deployment Solution V6.5
– WinZip V9.1
– ClearCube Grid Center V4.x

� One IBM HS20 blade server (two CPUs / 8 GB Memory / two 73 GB drives) to host
– VMware ESX V2.524 
– 4 x Windows XP Professional for hosted clients
– IBM Director Agent V4.22
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2.5  Implementation overview

The rest of this book is provided to help you set up an instance of this solution. The 
installation is done in the following order:

1. “Installation and configuration of IBM Director” on page 13
2. “Installation and configuration of Altiris Deployment Server” on page 27
3. “Other installation and configuration steps” on page 37
4. “Installing the Blade Storage Server Gateway” on page 39
5. “Installing VMware ESX” on page 45
6. “Creating the ClearCube Model virtual machines on VMware ESX” on page 47
7. “Configuring the ClearCube I/Port clients” on page 38
8. “Installing and configuring the DataCom Digital Surveillance solution” on page 38
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Chapter 3. Installation and configuration of 
IBM Director

IBM Director is a comprehensive systems manager designed for use across the IBM eServer 
product family. It is an integrated, easy-to-use suite of tools, that provides clients with flexible 
systems-management abilities to help maximize system availability and lower IT costs. IT 
administrators can view and track the hardware configuration of remote systems and monitor 
the component performance of processors, disks, and memory.

3
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3.1  IBM Director Server

The software products used in our lab environment were:

� Microsoft Windows 2003 Server Service Pack 1
� IBM Director Server 4.22

Each IBM Director Server can be installed with default options as described in the IBM 
Director 4.20 - Installation and Configuration Guide publication. Active Directory® is not 
required, but it or another supported LDAP user directory may be used to facilitate common 
user accounts and passwords across the IBM Director Servers in the farm.

The IBM Director Server includes an unattended installation option, which is convenient for 
deploying large numbers of management servers.

3.2  IBM Director Agent 

The IBM Director Agent can be installed on each target operating system to be managed. The 
Director agent enables tasks such as resource monitoring, software distribution, remote 
control, and process management.

In order to install the agent, it is recommended to use the unattended install option and to 
configure the DirAgent.RSP response file to specify the AddKnownServerAddress statement. 
When AddKnownServerAddress is specified and the Discovery Preferences setting 
“Auto-add unknown agents which contact the server” has been specified in the Director 
server, a new native managed object representing the agent will automatically be added to 
the server and inventoried when the agent is installed.

3.3  Installing IBM Director

IBM Director will be installed on your system management server: 

1. Log onto your IBM Director Server. We used a user ID of Administrator and a password 
of passw0rd.

2. Insert the IBM Director CD 1 into your CD-ROM Drive. 
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3. The main installation menu opens. Click Install IBM Director.

Figure 3-1   Director main menu

4. Choose the installation type. Click IBM Director Server Installation to start the 
installation.

5. Click Next to continue the installation.

6. Click Accept the license agreement and click Next to continue the installation.

7. Click Next.

8. Accept the default Features and installation directory and click Next to continue. If you 
want to install any additional IBM Director features, you may choose them at this time.

9. Fill out the required IBM Director Service account information as follows:

Local Computer or domain your server name 

User Name administrator

Password passw0rd (or the administrator account password you 
chose when installing the server

Confirm Password passw0rd
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10.Click Next to continue.

Figure 3-2   Enter service account information

11.Accept the default encryption settings (unchecked) and click Next.

12.Accept the Software Distribution settings and click Next. If you want to change the location 
of the Software Distribution directories you may do so at this time.

13.You are now ready to install IBM Director. Click Install.

14.Validate the IBM Director Agent network driver configuration and click OK.

15.IBM Director requires a database to store data objects in. For most configurations, you can 
select the Microsoft Jet 4.0 database and click Next. If you want to use another database 
engine, choose the database. You might be asked for additional configuration information 
depending on your database vendor.

16.When the installation ends, click Finish to complete the process. You will then be asked to 
reboot your system so that IBM Director will configure properly when the system reboots.
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3.4  Running the IBM Director Console

All remote access to the IBM Director Server is done via the IBM Director Console. To launch 
the console:

1. Open the Windows Start Menu.

2. Run the console by selecting IBM Director → IBM Director Console.

3. The Director Console opens and you will be required to log in to the IBM Director Server.

4. Enter the host name of the server and the user ID and password you entered during the 
IBM Director Server setup installation. (For our example, we used administrator and 
passw0rd.) Click OK.

5. Click Next to continue.

Figure 3-3   IBM Director Console

3.5  Discovery preferences for presence check

For WAN environments, it is often desirable to minimize the amount of management traffic 
across the wide area network links. To configure IBM Director for managing across a WAN, it 
is recommended that you disable the auto-discovery and presence check features. Under the 
Options menu in Discovery preferences, set these features to Disabled. Also, change the 
presence check period to Disabled on the SNMP devices, BladeCenter Chassis, and Physical 
Platforms tabs.

You also might want to enable the Auto-add unknown agents which contact the server 
setting if you plan to install IBM Director Agents. This feature enables agents to automatically 
add themselves as managed objects into the IBM Director Server when using the unattended 
install feature of the agent, thus eliminating the need to perform a broadcast or 
multicast-based discovery of agents from the server. See Figure 3-4 on page 18.
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Figure 3-4   Specify discovery preferences

3.6  Configuring the IBM Director Server

Here we specify our preferences.

3.6.1  Naming conventions for discovery preferences

Under Options → Discovery Preferences, you can configure an automatic naming rule for 
BladeCenter chassis and blade objects. This rule enables blades to be renamed 
automatically according to an assigned naming convention when new blades are discovered 
or inserted. For this environment, you should manually assign each new chassis a name 
indicating its branch or location. An automatic naming rule can then be configured for the 
blades to name them according to the branch (chassis name) and blade slot (location within 
the chassis). This naming convention should be followed throughout the solution, in order to 
ensure easy navigation between the hierarchical console, IBM Director Console, and other 
consoles. Figure 3-5 on page 19 shows how to configure a naming convention for the blades 
in the Discovery Preferences for Physical Platforms. The naming convention can be used in 
conjunction with the Auto Rename task on BladeCenter objects.

For Physical Platforms naming rules:

1. Select Options → Discovery Preferences.
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2. Click the Physical Platforms tab.

3. Remove all parameters from the selected parameters list.

4. From the Available Parameters list, select:

– %CHASSIS_NAME%
– Insert Additional Text for -
– Insert addtional text for Blade
– Insert a space (“ ”)
– %CHASSIS_SLOT%

Figure 3-5   Specify physical platform name rules

5. Click the BladeCenter Chassis tab (Figure 3-6 on page 20).
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6. For BladeCenter chassis naming rules:

a. Remove all parameters from the Selected Parameters list.

b. From the Available Parameters list select %MM_NAME%.

7. Click OK.

Figure 3-6   Specify BladeCenter chassis naming rules

3.6.2  Server preferences for inventory refresh

To minimize network traffic over the WAN links, you are recommended to disable inventory 
refresh after the initial inventory collection. Inventory is collected automatically any time a new 
object is added into the Director server, and inventory collection may be refreshed manually 
on specific objects at any time. Periodic inventory refresh may be disabled under Option → 
Server Preferences as shown in Figure 3-7. Even with the inventory refresh disabled, 
Director’s inventory will still be updated automatically when new objects are added and when 
blades and I/O modules are inserted or removed.

Figure 3-7   Specify server preferences for inventory refresh
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3.6.3  Server preferences for software distribution (optional)

If you are planning to use the IBM Director software distribution or update assistant tasks, you 
must install Director agent on each target OS and configure a remote File Distribution Server 
for each branch under Options → Server Preferences. The remote file distribution server 
acts as a remote file repository for the software packages to be distributed to endpoints. The 
remote file distribution server either may be populated automatically by IBM Director, or 
manually populated by some other means such as a satellite downlink. Note that distribution 
of IBM UpdateXpress software packages can be performed through the Update Assistant 
wizard under the Software Distribution task. Additional software distribution features in IBM 
Director require the Software Distribution Premium Edition be installed on the IBM Director 
Server.

On the Software Distribution tab under Server Preferences, ensure that the setting Do not 
stream distribution if redirected distribution fails is checked.

Figure 3-8 shows how to configure a remote file distribution server for each branch.

Figure 3-8   Configure a remote file distribution server

3.6.4  User administration

IBM Director includes role-based security, which enables individual administrators to view 
only specific groups of objects or tasks. This can be used to give particular administrators 
access only to certain branches. 

To give multiple administrators access to IBM Director, first add the users to the diradmin user 
group in the operating system or LDAP user directory (for example, Active Directory). Then, in 
the IBM Director Console, use the Options → User Administration task as shown in 
Figure 3-9 on page 22 to configure which groups each user is allowed to access.

 

 

 

Chapter 3. Installation and configuration of IBM Director 21



 

Figure 3-9   User administration menu

For a WAN environment, it is probably desirable to restrict users from performing particular 
tasks or operations that might not be appropriate for the environment. Figure 3-10 shows how 
to restrict user privileges to prevent access to the Discovery and Server Preferences and to 
prevent operations such as discovery from being performed by the user.

Figure 3-10   Specify user privileges
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IBM Director administrator accounts can also be configured to only be able to see specific 
tasks that are appropriate for the environment, as shown in Figure 3-11.

Figure 3-11   IBM Director administrator account preferences
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3.7  Configuring associations in the console

To show a tree view of the blades and switch devices contained in each BladeCenter chassis, 
you can turn on the Chassis Membership association. Right-click on white space in the Group 
Contents pane and select Associations → Chassis Membership as shown in Figure 3-12.

Figure 3-12   Chassis membership association 

3.7.1  Creating event action plans

Among the most powerful features in IBM Director are the ability to create filters for incoming 
events and associate automated actions to occur in response to the events. The event filters 
and action handlers can be customized in the Event Action Plan Builder, which can be 
accessed from the hammer icon on the toolbar. 

Figure 3-13 on page 25 shows how to create a simple event filter to capture all out-of-band 
events from any BladeCenter chassis. Out-of-band BladeCenter events appear under the 
MPA event type in the Event Filter Builder. An event action plan can be created that binds this 
event filter to a set of actions. Actions might include responses such as sending e-mail, 
forwarding an SNMP trap, or executing a command line program to dispatch a trouble ticket. 
To activate the Event Action Plan, drag and drop it onto a group of systems, such as the 
Chassis and Chassis Members dynamic group.
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Figure 3-13   Create an event filter 

Table 3-1 lists the out-of-band events from the BladeCenter Management Module.

Table 3-1   Out-of-band events

MPA.Component.I/O Module.Inserted MPA.Component.Service Processor.Configuration

MPA.Component.I/O Module.Removed MPA.Component.Service Processor.Log

MPA.Component.I/O Module.Configuration MPA.Component.Service Processor.Redundancy

MPA.Component.I/O Module.Redundancy MPA.Component.Service Processor.Network Stack

MPA.Component.I/O Module.Failed MPA.Component.Service Processor.Test

MPA.Component.I/O Module.POST MPA.Component.Service Processor.OOB.Enabled

MPA.Component.I/O Module.Power.On MPA.Component.Service Processor.OOB.Disabled

MPA.Component.I/O Module.Power.Off MPA.Component.Service Processor.Secure OOB.Enabled

MPA.Component.I/O Module.Insufficient Power MPA.Component.Service Processor.Secure OOB.Disabled

MPA.Component.Fan.Inserted MPA.Component.Service Processor.Failover

MPA.Component.Fan.Removed MPA.Component.DASD.Inserted

MPA.Component.Fan.Failed MPA.Component.DASD.Removed

MPA.Component.Fan.PFA MPA.Component.DASD.Failed

MPA.Component.Power Supply.Inserted MPA.Component.VRM.Failed

MPA.Component.Power Supply.Removed MPA.Component.USB.Inserted
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MPA.Component.Power Supply.Failed MPA.Component.USB.Removed

MPA.Component.Power Subsystem.Redundancy MPA.Component.USB.Owner

MPA.Component.Power Subsystem.Over Current MPA.Component.KVM.Owner

MPA.Component.Power Subsystem.Low Fuel MPA.Component.Chassis.Configuration

MPA.Component.Power Subsystem.Over Subscription MPA.Component.Chassis.Failed

MPA.Component.Power Subsystem.Mismatched 
Power Supplies

MPA.Component.Server.Power.On

MPA.Component.Blade Server.Inserted MPA.Component.Server.Power.Off

MPA.Component.Blade Server.Removed MPA.Component.PFA

MPA.Component.Blade Server.Communication MPA.Component.DIMM.Failed

MPA.Component.Blade Server.Insufficient Power MPA.Component.Bus.Communication

MPA.Component.Blade Server.Throttled MPA.Component.CPU.Failed

MPA.Component.Blade Server.VPD MPA.Component.CPU.Configuration

MPA.Component.Blade Server.Over Power Budget MPA.Deployment.POST

MPA.Component.Blade Server.Capacity on 
Demand.Enabled

MPA.Deployment.Boot

MPA.Component.Service Processor.Active MPA.Deployment.OS

MPA.Component.Service Processor.Inserted MPA.Environmental.Temperature

MPA.Component.Service Processor.Removed MPA.Environmental.Voltage
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Chapter 4. Installation and configuration of 
Altiris Deployment Server

Altiris’ Deployment solution contains two main components: the Deployment Server (DS) and 
the integration modules required to integrate the Deployment Server with Altiris’ Notification 
Server. This chapter discusses how to install and test the components.

4
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4.1  Planning and prerequisites

For the installation of Altiris Deployment Server, a system should meet the following 
requirements:

� Windows 2003 Server R2

� IIS (if Web access to the Deployment Server is required)

� RAM: 2 GB, although 4 GB is preferable if other services will be running on the system 
(such as IBM Director).

� SQL Server 2005 (SQL 2005 requires TCP/IP be enabled before use with Deployment 
Server)

At a minimum, two Deployment Servers are needed to support the Systems Solution for 
Branch Banking solution: One of the servers is for development of jobs for use in the 
environment and management of the other Deployment Servers servers, and the second 
server is for managing the individual remote locations. Additional Deployment Servers can be 
added depending on the number of remote locations to be supported. As noted earlier, each 
Deployment Server can handle approximately 100 remote locations. 

Blades in the remote locations must be able to map a drive back to the Deployment Server 
(using CIFS) because the Deployment Server must be able to pass jobs to the clients when 
booted to a managed state. However, the amount of traffic passed over this mapping is limited 
to the bootwork.exe and any configuration or batch files due to pending jobs.

4.2  Installing

A normal installation of Deployment Server is required for the Systems Solution for Branch 
Banking architecture, but not every component has to be installed. In particular the Web 
console might not have to be installed depending on administrative access requirements. To 
select which functions will be installed when running the DS installation, select the Custom 
Install option when starting the installation.

Note: The installation file comes in two flavors. One allows for the installation of the 
Deployment Server only. The other install file contains the Deployment Server and the 
integration modules for Notification Server. To install this version a Notification Server 
must be available for the installation. Both installation files are available by selecting the 
Download Evaluation link at:

http://www.altiris.com/products/DeploymentSolutionIBM/
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Figure 4-1   Deployment Server installation program startup window 

4.3  Configuration and maintenance

After the DS is installed, you must perform some post-installation tasks:

1. Configure Aclient global configuration
2. Configure DS global configuration
3. Import sample jobs (optional)
4. Import computer object and group membership (optional)
5. Blade configuration
6. Maintenance of the DS
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4.3.1  Aclient configuration

Global settings can be set for the Aclient within the DS console by going to Tools → 
Options → Agent Settings (Figure 4-2). Select the Force new agents to take these 
default settings check box, and click Change Default Settings. When enabled, these 
settings are forced on new systems that connect to the Deployment Server for the first time. 
Any of the client settings can be configured and should be reviewed on a per-client basis.

Figure 4-2   Specifying agent settings
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4.3.2  Deployment Server global configuration

In support of IBM blade servers, you must change the primary lookup key for the Deployment 
Server. This is because DS, by default, uses the MAC address of a system as the primary 
lookup within the system. With blades that have multiple network interfaces, this can be 
problematic. Changing it to the serial number alleviates any potential problems. 

This setting can be changed by going to Tools → Options → Global. Select the drop-down 
list at the bottom of the page and click Serial Number. Click OK when done.

Figure 4-3   Global tab with the global program options

One other setting of note on this panel is “Synchronize display names with computer names.” 
Setting this checkbox causes the name of a computer object within the DS to match its 
Windows host name. 

4.3.3  Import sample jobs

The Systems Solution for Branch Banking architecture includes a few sample jobs that can be 
used either directly or as a reference for building new jobs. In particular, these jobs cover the 
automated installation of the PXE server, replication of PXE boot images, and configuration 
and FileStore replication. Use either of the following actions to import the jobs:

� Right-click on a folder or object within the Jobs panel in the DS console and select Import.

or

� Select an object in the Jobs panel and go to File → Import/Export → Import Jobs.

Either method opens a window that enables the user to specify the file to import and where to 
import it to. In the folder the file was imported to, a new folder appears called Systems 
Solution for Branch Banking jobs that contains the jobs that were previously described.

IBM also provides functional DS jobs within their ServerGuide™ offerings. The jobs offered 
within the ServerGuide can be used for server installation (including image creation and 
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capture), raid configuration, and firmware updating. Again, these jobs either can be used as is 
or modified as needed. See the ServerGuide documentation for help with installation and use 
of these jobs.

4.3.4  Computer object import

Computer objects can be imported within the DS console. Imported objects are considered 
“virtual” objects until a client system contacts the DS and matches an existing virtual object 
record. At that point, the object becomes a “real” object that can be managed. A CSV file 
format is supported by Altiris and is defined in the product documentation. If IBM Director is 
being utilized it is possible to get all of the necessary information about the actual hardware in 
the environment from IBM Director and is use it to create an import file that can be used to 
populate the DS. This includes group membership information. Importing computer objects is 
achieved by going to: File → Import/Export → Import Computers and selecting an import 
file from the resulting open file dialog box. 

Pre-populating the console can be an affective way of ensuring a consistent navigational 
experience within the console. It is recommended that each remote location be treated as a 
group and that all of the blade servers for that same remote location are members of the 
group. This will produce a structure that is easy to navigate within the DS console. 

Figure 4-4   Server grouping in the DS console

4.3.5  Blade configuration

Blade servers must be configured to use PXE for use within the Systems Solution for Branch 
Banking architecture. A blade with multiple NICs should be configured so that only one of 
them boots to PXE. This can be configured in a blade’s BIOS configuration, and should be 
done to keep the blades from attempting multiple PXE boots upon each reboot. Furthermore, 
if the primary lookup key (as noted above) is not modified, the DS might register multiple 
objects. This is because, by default, a system’s MAC address is used as the primary lookup. 
Because each NIC has a different MAC address, this can lead the DS to think that each 
responding NIC is a separate system.
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4.3.6  Maintenance of the Deployment Servers

The deployment servers used in the Systems Solution for Branch Banking should be backed 
up on a regular basis. In particular the DS database (eXpress) should be backed up, as well 
as the entire “express” share directory (c:\Program Files\Altiris\express\Deployment Server\ if 
installed in the default location). 

In case of system loss or failure, the server can be rebuilt if these things are available. Rebuild 
the server, reinstall SQL Server, and rebuild the database, then install the DS software. It will 
detect the existing database and ask whether it should be overwritten; keep the current 
database. As a final step after installation, rebuild the previous “express” share directory. This 
will complete the rebuild of the system.

4.3.7  Boot image configuration

The boot images for Initial Deployment and Managed PC must be configured to map a drive 
back to the correct Deployment Servers. By default boot images will need to be maintained for 
each Deployment Server. This is because the boot image contains information that points the 
image back to the supporting Deployment Server. Boot Images can be configured using the 
Boot Disk Creator. 

Map a secondary drive to the local FileStore using the Boot Disk Creator Wizard. (Or you can 
modify the autoexec.bat file to do this mapping.) As mentioned in the overview, how the local 
FileStore is found depends on the client environment. The recommended approach is to have 
the NetBIOS name be consistent across the environment. If this is not possible, there are 
other approaches including using lookup tables based on subnet and DNS naming 
approaches. In either case finding a local FileStore is necessary if the WAN traffic is to be 
kept to a minimum. 

DS provides some samples for accomplishing this. Visit:

http://kb.altiris.com/display/2n/kb/article.asp?aid=31186&n=1&s=1

To learn about new PXE redirection features, visit:

http://kb.altiris.com/display/2n/kb/article.asp?aid=24298&n=1&s=1

After the boot disk images have been modified it is necessary to create the PXE boot image 
by going into the PXE Configuration tool, selecting either Initial Deployment or Managed PC 
and clicking the Make Boot Files button. This relaunches the Boot Disk Creator tool. 
Right-click the appropriate boot image and select Create PXE boot file to create the boot 
image. 

Because the boot image is now local to the Deployment Server, it must be copied to the 
FileStore for replication out to the remote locations. This can be further automated using a DS 
job. When replication is complete, the boot images are automatically replicated to the local 
PXE servers for use.

4.4  Testing scenarios

This section discusses various situations that might come up when the Systems Solution for 
Branch Banking architecture is in place. In particular, it outlines various scenarios and how to 
deal with them.
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The Altiris Deployment Server supports “rip and replace” functionality for blades through the 
use of its Server Deployment Rules (also known as change rules). Currently, four deployment 
rules can be selected and configured (Table 4-1).

Table 4-1   Deployment rules:

This functionality appears only on installed and identified blades. It can be found on a 
computer object’s properties under the Bay option. By default the rule is set to Wait for User 
Interaction, which enables a system to come up and wait for an administrator to deploy any 
necessary jobs to the system. 

For the Systems Solution for Branch Banking architecture it was decided that the default rule 
worked exceptionally well for most cases. The default setting allows systems to come up 
without having unexpected behavior. The text below describes the behavior of the system 
under various scenarios using this configuration. It is assumed that PXE is for all the systems 
in question and that PXE services are running.

4.4.1  Scenario 1: Blade removed and reinserted

In this scenario a blade is having some necessary work done on it. The blade is removed from 
the chassis; the necessary work is performed then reinserted into the chassis. The system 
boots to a Managed PC state, reports its status, then reboots into the local operating system.

4.4.2  Scenario 2: Blade is removed and a new one inserted

In this scenario a blade is removed due to problems. A new blade is inserted into the same 
slot. The blade is recognized as a new system and is treated as such. The blade boots into 
Initial Deployment and waits for instructions. In the DS Console, the blade object is identified 
by its serial number and exists in the same location as the previous blade. 

4.4.3  Scenario 3: Blade is removed then reinserted into a new slot

A blade is removed from the chassis, then reinserted into the wrong slot. The blade boots into 
a Managed PC state, reports its status, then reboots into the local operating system. The 
information in the DS console is updated to reflect the new slot location. 

4.4.4  Scenario 4: Blade is removed, new blade inserted, old blade reinserted

This scenario is a special case. Different behaviors are seen, depending on the order of 
insertion. For this example, we have blades 1 and 2. If blade 1 is removed from the chassis, 
then reinserted into a different slot, blade 1 will be treated as a known system and will 
eventually boot into the local operating system. Furthermore, the slot information of blade 1 

Name: Functionality:

Re-deploy 
computer

Rebuilds a blade by reviewing its job history, finding the last imaging job that was run, and starting 
from that point re-running the imaging job and every subsequent job thereby rebuilding the 
system. This occurs when a new blade is inserted into a redeploy configured slot in the chassis.

Run predefined job Runs a specified job whenever a new blade is detected in a slot.

Ignore the change Allows a new blade inserted in a slot to be ignored. If a known blade is inserted into a slot its slot 
information will be updated to reflect the new position.

Wait for user 
interaction

A new server comes up and waits for an administrator to do something. An icon on the DS console 
indicates that the server is waiting (yellow yield symbol).
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will be updated to reflect its new position in the chassis. If, however, a new blade (blade 2) is 
inserted into the chassis in the same slot that blade 1 originally occupied and before blade 1 
is reinserted, something interesting happens. Blade 2 is a new blade, unknown to the 
Deployment Server and is treated as such. It will boot to Initial Deployment and wait for 
further instructions. Interestingly, within the DS console, instead of receiving a new computer 
object under New Computers, the old blade 1 object is updated to reflect the new blade’s 
serial number and name. Now, when blade 1 is reinserted into the chassis in a different slot or 
the same slot it is treated as a new system and is unknown to the Deployment Server. It will 
boot to Initial Deployment and wait for further instructions. This is because information that 
the Deployment Server knew about the system was overwritten when blade 2 was inserted 
into the chassis. 

4.4.5  Scenario 5: Server rebuild

Server failure is a normal event in any IT environment. How it is dealt with, however, is 
another matter entirely. One of the goals for the Systems Solution for Branch Banking 
architecture is to support a retail environment remotely with as little administrative overhead 
as possible. To that end, rebuilding a server remotely is entirely possible. In fact, rebuilding 
one of the supporting blades is entirely possible. The following steps outline the process that 
is required to “rebuild” a management server in a catastrophic failure:

1. Delete the existing blade object out of the DS console.

2. Fix or replace the broken blade and insert it into the chassis.

3. Start the blade. Because it is unknown to the system, it will boot to Initial Deployment state 
and wait for further jobs. At this point the system is ready to have jobs deployed to it. 
Depending on the blade setup configuration, jobs might have to be deployed to configure 
RAID or disk access. Otherwise an imaging job can be deployed.

4. After an operating system has been deployed, any necessary configuration jobs can be 
deployed to finish the configuration such as system renames, IP configuration, and so on.

5. After the OS is functional, other services can be reinstalled onto the system. The first thing 
that should go back onto a supporting blade is the FileStore, because most DS jobs utilize 
files from the FileStore. 

6. Following the FileStore installation, the PXE server installation can be deployed. 

7. After the PXE server installation is complete the PXE management configuration job 
should be deployed.

8. As the final piece of the PXE services, the current boot disk images should be deployed to 
the PXE server.

9. At this point the blade is rebuilt. Other services can be deployed to the system as needed.

Note: PXE Services should be installed only after the system has received a static 
address. DHCP reservations can also be used to ensure that the system is assigned 
the same address at each boot. The PXE service is bound to the IP address and will 
break if the IP address changes. If the IP address does need to change, uninstalling 
and reinstalling the service will fix any problems.
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Chapter 5. Other installation and 
configuration steps

Some of the components, including ClearCube and DataCom, can be installed by using 
documentation and downloads from their Web sites. This chapter provides those links.

5
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5.1  Installing the ClearCube Grid Center software

See the ClearCube Web site for installation documentation, including: 

� Hosted Client Solutions with IBM BladeCenter and ClearCube Management Software

http://www.clearcube.com/downloads/english/IBM_CC_solution.pdf

� ClearCube Grid Center (Now ClearCube Sentral)

http://www.clearcube.com/controller/software.php

� Site Preparation for ClearCube Installation 

http://www.clearcube.com/support/controller/downloads.php?id=292 

� ClearCube Grid Center Admin Guide:

http://www.clearcube.com/support/controller/downloads.php?id=260

For instructions on implementing the ClearCube Grid Center software, refer to their Web site:

� Grid Center Admin Guide 4.11 

http://www.clearcube.com/support/controller/downloads.php?id=260

See the ClearCube links in “Related publications” on page 69.

5.2  Configuring the ClearCube I/Port clients

For instructions on configuring a ClearCube I/Port client, see the following documents:

� ClearCube I/Port

http://www.clearcube.com/controller/user_port.php

� I/Port Quick Reference Guide

http://www.clearcube.com/support/controller/downloads.php?id=264

� I/Port I8020/I8820 Quick Start Guide 

http://www.clearcube.com/support/controller/downloads.php?id=345

� I/Port I8020/I8820 Quick Start Guide 

http://www.clearcube.com/downloads/english/GridCenterDatasheet.pdf

See the ClearCube publications listed in “Related publications” on page 69).

5.3  Installing and configuring the DataCom Digital Surveillance 
solution

See the DataCom Web site http://www.datacomnvs.com for documentation such as this:

� Frequently Asked Questions: 
http://www.datacomnvs.com/adobe%20files/Frequently%20Asked%20Questions.doc

� DataCom Systems Network Video Servers: 
http://www.datacomnvs.com/adobe%20files/Product_Overview_VAR_1.0.pdf

� Installing and configuring the DataCom Digital Surveillance solution

http://www.datacomvideo.com/index.html
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Chapter 6. Installing the Blade Storage 
Server Gateway

Windows Storage Server provides file-sharing services for storing common applications and 
images to support remote bank branches. This chapter explains how to configure Windows to 
allow sharing between servers.

6
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6.1  Configure your IBM BladeCenter HS20 storage server

1. Log onto your IBM HS20 Storage Server using the administrator name and password you 
used when configuring the server. 

2. To access the server, enter https://servername:8098 in your Web browser.

3. When you see a security warning to accept the certificate, click Yes to continue.

4. Enter your administrator name and password, and click OK. You might need to repeat this 
process a second time depending on your network configuration.

5. The storage server administration window opens. You need to create two folders and then 
share them as network resources. To create the folders, click the Shares tab.

Figure 6-1   Storage server administration main menu

6. The Shares window opens. Click the Shares sub-tab.

Figure 6-2   Shares tab
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7. In the Shares sub-tab window, create two shares called Altiris and FileStore. To create 
the file share, click New.

Figure 6-3   Shares sub-tab

8. To create file FileStore file share, enter the following information:

Share Name FileStore
Share Path c:\FileStore
Create folder Yes
Share Type Windows

Figure 6-4   Create file share definition
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9. When you have entered the required information, click the Windows Sharing tab in the 
left navigation bar. 

Figure 6-5   Windows sharing tab

10.Set the permissions so that remote users can write to the directory. For our example, we 
set up the following privileges:

Everyone Read 
Administrator Full Control

11.To add authorized users to the Share, click User in the user list then click Add. When the 
user or group is in the list, change the Allow setting to Full Control. Click OK when you 
are done.

12.Repeat the previous steps for the Altiris file share using the following settings:

Share Name Altiris
Share Path c:\FileStore\Altiris
Create folder Yes
Share Type Windows 

Windows Sharing permissions:
Everyone Read 
Administrator Full Control
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When you are through creating the Altiris share, a list of shares on the Windows Storage 
Server is displayed.

Figure 6-6   List of shared folders

If both shares are listed, you may close your browser window. You are through configuring 
the IBM BladeCenter HS20 Storage Server.
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Chapter 7. Installing VMware ESX

See the VMware Web site for installation information about VMware ESX:

http://www.vmware.com/products/vi/esx/

At that site, click Documentation to find a list of manuals about VMware. Then click each 
VMware product to view the release notes, manuals, guides, and resources that are available 
for all versions of that product. For white papers, tech notes, compatibility guides, and other 
technical papers, click Technical Papers.

� Data Center Products

– VMware Infrastructure 3  (ESX Server 3.x, VirtualCenter 2.x & VCB)

– Compatibility guides, release notes, online library, and resources

� VMware ESX Server 2.x

– Compatibility guides, release notes, manuals, and guides

� VMware VirtualCenter 1.x

– Release notes, manuals, and guides

� VMware SDK & API

– Resources for VI SDK, CIM SDK, Guest SDK, Programming API, and Scripting API 

– Development and Testing Products

� VMware Workstation

– Release notes, manuals, and guides

� VMware Server

– Release notes, manuals, and guides 

7
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Chapter 8. Creating the ClearCube Model 
virtual machines on VMware ESX

VMWare ESX server is used for virtualized infrastructure for partitioning, consolidation, and 
managing servers. It provides the ability to host multiple virtualized servers on a common 
computing platform. This chapter describes how to install the software.

8
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8.1  Create a virtual machine 

1. Log onto VMware by entering http://machine in your Web browser, where machine is the 
host name of your VMware server.

2. To the security alert to accept the certificate, click Yes.

3. Log onto the VMware server using the super user ID that you assigned during the VMware 
installation. In our example, we used root and passw0rd.

4. After entering the super user ID, click Log in to open the VMware Management interface.

Figure 8-1   VMware management interface
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5. Create a virtual machine that will be used as a base image for creating several virtual 
machines. Click Add Virtual Machine on the VMware Management Interface.

Figure 8-2   Add virtual machine

6. In the Add Virtual Machine window, change the standard options as follows:

Guest Operating System Microsoft Windows XP Professional
Display Name ClearCube Base Image
Location /root/vmware/winXPPro/ccvmBase.vmx

7. Click Next.
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8. The Virtual Machine Configuration appears, where you can change the memory settings. 
In our configuration we used 1024 MB. Depending on the amount of server memory you 
have and the number of virtual machines, this value might have to change. After changing 
the memory settings, click Next. 

Figure 8-3   Virtual machine configuration

9. At the warning regarding SCSI driver support for VMware and Windows XP, click OK to 
create your virtual machine. 

10.Now create a virtual disk for the virtual machine to use. Click Create Blank Virtual disk.

Figure 8-4   Virtual disk configuration
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11.The Edit Virtual Disk Configuration window opens. Enter the following settings for your 
virtual disk. (In our example, we have assigned an 8 GB virtual disk to this virtual machine. 
Depending on your local or SAN-based storage you may alter this value depending on 
your requirements.)

Image File Location vmhba2:0:0:5: 21.8 G free (If you have additional storage attached 
to your server, you may choose it from the pull-down menu.)

Image File Name ccvmBase.vmdk
Capacity 8000 M

Click Next to continue.

Figure 8-5   Edit virtual disk configuration
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12.Finally, the virtual machine configuration is finalized. The virtual machine control window 
for your ClearCube base image opens.

Figure 8-6   Virtual machine control window

8.2  Installing the VMware remote console

To interact with VMware virtual hosts, you must download the VMware Remote Console. This 
can be done from the VMware Management interface main window. 

1. At the bottom of the window, click the link for the remote console. In our example, we 
install the Windows version. 

2. When you click the link, you will be asked to save or run the executable. Click Run. After 
the file is downloaded to your workstation, the installation program will start.

3. Click Next.

4. Accept the license agreement and click Next.

5. Accept the default installation directory and click Next.

6. Now you are ready to install. Click Install to continue.

7. After several minutes, the installation completes. Click Finish.
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8.3  Creating the ClearCube base image

Now create a base image of a virtual machine: 

1. Before you create the base image, you must download the VMware virtual SCSI driver 
from http://www.vmware.com/download. The file is called vmscsi-1.2.0.2.flp. After 
downloading the file, FTP it to the VMware server under the /tmp directory. You will need 
this file for installing Windows XP Professional.

2. Insert the Windows XP Professional CD in the CD drive of your IBM BladeCenter and click 
Media select to assign the CD drive to your blade server.

3. Open the VMware remote console for the ClearCube Base Image by double-clicking the 
Windows icon to the left of the virtual machine name. When you click on the machine 
name, the remote console login opens.

4. Enter the super user ID password you used when you installed VMware ESX. In our 
example we enter passw0rd as our password.

5. The remote console window opens. Power on the virtual machine by clicking Power On in 
the upper remote console window. The VMware virtual host boots.

Figure 8-7   Remote console window

6. When the Windows XP Installation starts, press F6 as prompted, because you will need to 
load a third-party SCSI driver.

7. The Windows installation continues. Press S to specify additional drives.

8. At this point, you must exit the VMware remote console by pressing Control+Alt. Control 
returns to the Remote console menu.
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9. Attach to the VMware virtual SCSI driver that was downloaded in step 1. Select 
Devices → Floppy0 → Edit. 

10.The Configuration Editor opens. Change the floppy connection from physical drive 
/dev/fd0 by selecting Use Floppy Image and entering or browsing to the following floppy 
image file: /tmp/vmscsi-1.2.0.2.flp/. Click OK to continue.

Figure 8-8   Configuration editor of remote console menu

11.Attach the floppy image to the virtual machine by selecting Devices → Floppy0 → 
Connect. 

12.Now attach back to the remote console to continue with the Windows XP installation.

13.Click S in the VMware remote console to specify the virtual SCSI driver. The driver 
selection window opens. Choose the VMware SCSI Driver and press Enter.

14.Insert disk when prompted.
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15.When prompted, press Enter to access the floppy image.

Figure 8-9   Select device to be loaded

16.The VMware SCSI controller driver is installed. You are asked whether you want to install 
more drivers; we do not need to do any more, so press Enter to continue.

17.Windows setup continues as normal. It is beyond the scope of this document to show all 
the steps involved with installing Windows, but we show the specific tasks and 
configuration relative to this solution.

18.Choose to perform a standard installation as follows:

a. Choose a standard installation.

b. Create a partition that contains the entire VMware file system size you choose 
previously.

c. Format the file system as NTFS.

d. During the Windows Graphical setup, you will be asked to choose an administrator 
password. In our example we used passw0rd.

e. During the Windows Graphical setup, you will be asked to choose a user name and 
password. In our example we used user1 and passw0rd.

f. Take the default network settings.

g. Choose the correct time zone and set the clock to your local time.

19.When the Windows installation is completed, you should disconnect the virtual floppy by 
selecting Devices → Floppy0 → Disconnect.
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8.4  Post-installation tasks

After the initial Windows XP Professional installation completes, several other tasks must be 
completed before we prepare the virtual machine model so that cloned virtual machines may 
be created.

8.5  Service packs and hot fixes

You should install the latest available service pack for Windows XP professional in addition to 
all required hot fixes, which are available from the Microsoft Download service. This can be 
set up so all fixes are automatically downloaded to your Windows XP installation.

8.6  Applications

You should install all applications that you would like to include in the model image so that 
they will be available in all of the cloned virtual machines you will be creating. In our example, 
we have included Symantec AntiVirus, WinZip, and Adobe Acrobat Reader. Do not install a 
Java™ Runtime Environment at this time, because the ClearCube GridCenter client will install 
its own version.

8.7  Enabling remote access to the virtual machine

ClearCube Grid Center uses RDP (Remote Desktop Protocol) to allow access from I/Ports to 
the virtual machines, so we must enable the users for remote access:

1. From the Windows Start Menu, open the control panel from the settings menu.

2. In the control panel, click the System icon.

3. When the system icon appears, select the Remote Tab.

4. Under Remote properties, select Allow users to connect remotely to this computer 
and click OK.

5. Close the system properties page and close the control panel.

8.8  Installing the VMware tools

VMware tools must be installed in the virtual machines model we are creating. The VMware 
tools provide specialized drivers and increase performance of the virtual machine environment. 

To install VMware tools:

1. Make sure your ClearCube Base image virtual machine is booted and the VMware remote 
console has been started.

2. From the VMware Remote Console main menu, select Settings → VMware Tools Install.

3. A window opens asking whether to install or cancel the VMware tools installation. Click 
Install to continue.

4. When the VMware tools installation screen appears, click Next.

5. When the setup type screen appears, pick Typical and Next to continue.
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6. Click Install to start installing VMware tools.

7. You might be asked several times to accept the installation of a driver that has not passed 
Microsoft Certified Driver testing. This is normal; choose the Continue Anyway button to 
continue.

8. After all of the drivers are installed, the VMware tools installation will be completed. 

9. Click Finish. 

10.The VMware virtual machine must reboot so that VMware tools can run. When asked to 
reboot the virtual machine, click Yes to restart your system.

8.9  Installing the IBM Director Agent

1. Insert your IBM Director CD. The installation menu appears.

2. Click Install IBM Director.

3. Click IBM Director Agent Installation.

4. The Installer opens. Click Next.

5. Accept the license agreement and click Next.

6. Choose the default installation directory and options and click Next.

7. Accept the default security options. (If your site requires these, be sure that these options 
match the ones you used when you installed the IBM Director Server). Click Next.

8. Accept the default Software distribution settings and click Next.

9. Begin the installation by clicking Install.

10.Make sure Enable driver is checked when network driver configuration dialog appears, 
then click OK.

11.When the installation is complete, you will be required to reboot the machine. Click Yes to 
reboot.

8.10  Installing the ClearCube Grid Center client 

ClearCube Grid Center requires a client component to be installed on each virtual machine 
so that the Grid Center server can make connections between the I/Ports and the virtual 
machines. 

To install the ClearCube Grid Center client:

1. Make sure your ClearCube Base image virtual machine is booted and the VMware remote 
console has been started.

2. Insert your ClearCube Grid Center CD into the CD drive of your IBM BladeCenter and 
click Media select to assign the CD drive to your blade server.

The ClearCube Grid Center installation page opens.

3. To start the installation, choose the Grid Center 4.1 One-step installation. If you receive a 
security warning about running a downloaded application, choose Open to run the 
application.

4. The installation wizard opens. Click Next to continue.

5. At the warning about removing older versions of Grid Center, just click OK to continue.
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6. The installation setup type opens. Select Grid Center Blade Client and click Next to 
continue.

7. The Select feature installation window opens. Accept the default and install all features 
listed. 

8. If you receive a security warning about running a downloaded application, choose Open to 
run the application.

9. The ClearCube Grid Center client installation begins. You will be asked to enter some 
organization information such as user name and organization. Take the defaults that were 
entered when you installed Windows.

10.Click Yes to accept the license agreement. The installation finishes. The last step is to 
configure the primary and secondary names of the Grid Center server we installed 
previously.

11.Enter the host name of the Grid Server in both the primary and secondary fields and click 
Next to continue.

12.You will be guided through installing the following features:

– Java 2 Runtime
– Active State Perl
– Perl Plug-in 1.1 for ClearCube Technology
– ClearCube Distributed Computing Infrastructure

Click Next to continue.

For each product installation, take the default installation options. If you receive a security 
warning about running a downloaded application, choose Open to run the application.

Four separate product installations will be performed sequentially.

13.Finally, reboot the virtual machine when the ClearCube Client has been installed. Choose 
Yes, I want to restart my computer to reboot the system.

8.11  Running the Sysprep setup manager

To enable a system to be copied or cloned to other systems, the base version of the image 
must be prepared by using the Sysprep program: 

1. Make sure your ClearCube Base image virtual machine is booted and the VMware remote 
console has been started.

2. Log onto the ClearCube Base image virtual machine as user1.

3. Insert your Windows XP Installation CD in the CD Drive of your IBM BladeCenter and click 
Media select to assign the CD Drive to your blade server.

4. Using the Windows explorer, browse the Windows XP Professional installation CD located 
in Drive D.

5. Create a folder on your local hard drive call c:\sysprep.

6. Copy deploy.cab from the \support\tools directory of the CD to your local hard disk in a 
folder called c:\sysprep.

7. Open deploy.cab and extract the contents to the c:\sysprep directory using WinZip or 
Windows’ built-in compression tool.

After you have expanded the contents of deploy.cab into c:\sysprep, run the Sysprep setup 
manager. This application helps prepare the answer file that will be used when Sysprep is 
run.

 

 

 

58 IBM Systems Solution for Branch Banking: Installation Guide



 

8. From the Windows start menu, launch the Sysprep setup manager by running 
c:\sysprep\setupmgr.exe.

9. The setup manager opens. Click Next.

10.Create a new sysprep.inf file by choosing Create new and clicking Next. If you have an 
existing sysprep.inf file you want to work with, you may copy it to the system and select 
Modify existing, including the file you want to modify.

11.Choose Sysprep setup as the setup type and click Next to continue.

12.Choose Windows XP Professional as the product type and click Next to continue.

13.Choose Yes, fully automate the installation. Click Next.

Figure 8-10   Setup manager

The Setup Manager opens. Enter the information, which will be used for every cloned 
system. To change the settings for a given category, click the setting on the left pane. The 
values to be set will appear on the right.

The following settings should be made:

– General Settings
– Name and Organization
– Time Zone
– Product Key 
– Network Settings
– Computer Name (select automatically generate computer name option)
– Advanced Settings

14.Click Next to cycle through each settings category. When you are done, you will be 
prompted to save the Sysprep file to c:\sysprep\sysprep.inf. Take the default setting and 
click OK.

15.When you are done, the Sysprep setup manager closes. Click Cancel to complete.

You may view the details of the settings that are to be written to c:\sysprep\sysprep.ini file 
by using Windows Notepad or another text editor.
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8.12  Running Sysprep

After the Sysprep setup manager has been run and a sysprep.inf file has been prepared, run 
Sysprep. Ensure that all prerequisite software has been installed on your system that you 
want to be included as your base. After Sysprep is run the clone systems will be created. If 
you want to add additional applications, you must go back and update the model image or 
add the application to each system individually.

1. From the Windows Start menu, lchoose Run, and launch Sysprep by typing 
c:\sysprep\sysprep.exe.

2. When Sysprep starts a warning is displayed. Read the warning and click OK to continue.

3. From the System Preparation Tool configuration window (Figure 8-11), choose Use 
Mini-Setup because we have prepared a sysprep.inf file. Using mini-setup runs a fully 
unattended installation of the Windows XP virtual machine when cloned.

4. Click Reseal. This causes the sysprep.inf file to be read and the system preparation 
process to run. When it completes, the system will shut down.

Figure 8-11   System preparation tool configuration screen

You are now ready to create clone virtual machines to use as your ClearCube I/Port clients.
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8.13  Cloning the model image to create the client virtual 
machines

Now that we have prepared the model image, we must clone the model image to create the 
actual client virtual machines. This is done by copying the actual disk file on the VMFS 
(VMware file system) and creating a new copy. 

1. To clone the model image, click the Manage Files link of the VMware management 
interface. It is located on the upper-right section of the window.

Figure 8-12   Specifying cloning process

2. The VMware File Manager window opens. Click the vmfs directory tree and then the 
device directory, which has space to hold the copies of the cloned virtual machines. Your 
output should look similar to Figure 8-13.

Figure 8-13   VMware file manager
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3. Click the ccvmBase.vmdk file and click Copy on the lower-right section of the window. 

4. Click Paste.

5. When the copy is completed, you must rename the copied version, which is called 
copy_of_ccvmBase.vmdk. To rename this file, click on the file name and click the Edit 
properties button located on the bottom-right section of the screen.

6. The Edit Properties window opens. Change the name of the file to teller01.vmdk and 
click OK.

7. When the move is completed, the new virtual machine file will be listed.

8. Repeat the copy-and-paste using the ccvmBase.vmdk base image for as many virtual 
machines as you require. In our environment, we used three client virtual machines.

8.14  Starting, running, and configuring the client virtual 
machines

We now create the virtual machines that will be used to host our virtual clients:

1. Click Add Virtual Machine on the VMware Management Interface.

2. The Add virtual machine window opens. Change the standard options as follows:

Guest Operating System Microsoft Windows XP Professional
Display Name teller01
Location /root/vmware/winXPPro/teller01.vmx

3. Click Next.

4. The Virtual Machine Configuration opens. Depending on the amount of server memory 
you have and the number of virtual machines, the memory settings value might have to 
change. In our configuration we used 1024 MB.

Figure 8-14   Specify memory settings
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5. After changing the memory settings, click Next.

6. At the warning regarding SCSI driver support for VMware and Windows XP, click OK to 
continue.

7. Your virtual machine is created. Next, create a virtual disk for the virtual machine to use. 
Click Existing Virtual disk to continue.

8. Choose the location and name of the existing virtual disk to use for the virtual machine. 

Image File Location Choose location where you copied the model virtual disk in the 
previous step

Image File Name teller01.vmdk

9. Click Next to continue.

10.The virtual machine configuration is finalized. The virtual machine control window for our 
ClearCube base image opens.

Figure 8-15   Finalized virtual machine configuration

11.Make sure that the virtual machine starts when VMware starts (this is an implementation 
issue that should be decided). We want to edit the startup options.

12.Click the Options tab.
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13.Change the system start options by clicking Edit next to the System Startup Options.

Figure 8-16   Specify system start options

14.Select the Start virtual machine checkbox and click OK. 

15.Close the Virtual Machine Configuration window.

16.Repeat the virtual machine creation process for as many virtual clients you need to create. 
Remember, this is usually limited by the amount of memory and disk storage is available.

8.15  Post-installation tasks

After rebooting each client virtual machine, you need to rename the client VM changing the 
system name in the Windows XP Control Panel system applet

1. Click Start → Control Panel.

2. Click the System Applet.

3. Click the Computer Name tab.

4. Click Change to rename the computer.

5. Enter the client virtual machine’s new name in the Computer Name field.

6. Click Apply. You will then be prompted to reboot.

7. Reboot the client virtual machine.
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Appendix A. Teller application

This chapter describes how to install the application that simulates the teller environment and 
enables us to test the underlying infrastructure. It simulates all of the major functionalities of a 
bank branch teller. It is a WebSphere Everyplace client 6.0 extending the J2EE programming 
model to the client for performance and operational resiliency. It can perform functions like:

� Look, modify, and delete the account holder details

� Create bank accounts

� Transfer money between accounts

� Deposit and withdraw money

This application can run in both online and offline modes. When in offline mode the 
transaction data is stored locally and synchronized with the server as soon as the application 
comes online.

There are two components to this application. The server component has the server 
application deployed on WebSphere Application Server, WebSphere MQ, and the database. 
The client is WebSphere Everyplace Client, which hosts the client application and makes 
connections to the server using Web services. 

A
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Server installation
Use the following steps to get the server installed:

1. Get the server image (eserver25b1_new).

2. Boot the image in VMware and log in as root with the password ibmpass. 

3. Run yast2 or your tool of choice and change the IP address to something valid in your 
environment.

4. Check the file /etc/hosts and verify that eserver.networkfi.test is mapped to your new IP 
address. Yast2 should have done this for you.

5. Make sure eserver.netwokfi.test is resolvable on all clients that will connect to this server 
(suggest putting in master image).

6. Reboot the image.

7. After the system comes up, log in again (/root/ibmpass).

8. Most needed services start up as iniit.d daemons. Only WebSphere Application Server 
and the MQe gateway have to be started manually. Enter:

/opt/WebSphere/AppServer/bin/startServer.sh server1 

to start WebSphere Application Server. You can log in to the WebSphere admin console 
as wpsadmin/ibmpass.

9. Enter /opt/WebSphere/AppServer/bin/startMQe.sh to start the MQe gateway.

10.To shut down cleanly, use /opt/WebSphere/AppServer/bin/stopServer.sh server1. After 
this completes you may shut down the OS normally.

11.From now on, begin at step 5 above when starting the image.

Client installation
Required software:

� WebSphere Everyplace Client Deployment code
� Modified com.ibm.pvc.wct.platform plug-in files
� com.ibm.bankdemo.site.jar and bankdemo_wsclient.properties files

Use the following steps to get the client installed:

1. Install the WebSphere Everyplace Client by unzipping the zip file (select full installation, do 
not select the WEDM server-managed configuration).

2. Back up the com.ibm.pvc.wct.platform plug-in in /Program 
Files/IBM/WED/rcp/eclipse/plugins and replace it with the new plug-in with custom OFN 
images and branding.

3. Copy com.ibm.bankdemo.site.jar and bankdemo_wsclient.properties to a temporary 
directory on the client.

4. Make sure your client has a /etc/hosts (or the equivalent) entry for eserver.networkfi.test 
that points to the server image.

5. Start the WED (WebSphere Everyplace Deployment) client and select Install under 
Applications.

6. Click Add zip/jar location and select the site jar above. Make sure the 
com.ibm.bankdemo.site.jar appears in the location list and is checked.
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7. Click Next. Make sure the “com.ibm.bankdemo.sample feature for WebSphere 
Everyplace Deployment...” feature (and only that feature—not the samples gallery for 
RAD) is checked.

8. Click Next again. Make sure the location selected is under C:/Program 
Files/IBM/WED/shared (or /opt/IBM/WED/shared). Click Finish. Choose Install anyway 
when warned about unsigned features.

9. Shut down WebSphere Everyplace Deployment after it restarts.

10.Copy the properties file (overwriting the one that is already there) to C:/Program 
Files/WED/shared/eclipse/plugins/com.ibm.bannkdemo.wsclient_1.0.0.

11.Start the client. Click Open and launch OFN Teller Application. 

Test scenario
The teller (Sally Thomas) starts her client system and launches the WebSphere Everyplace 
Deployment client. The WED workbench appears with the branding and visuals associated 
with the financial institution.

Sally opens the OFN Teller from the WED application switcher and logs in. The OFN network 
status indicator shows online. She logs in to the system using sallyt and ibmpass. The ID 
and password are prefilled. The application will accept any user ID and password entered.

Alice Sheen and John Walker walk up to the teller to make a deposit. Alice wants to make a 
deposit and John wants to make a withdrawal. Sally is already logged in to OFN Teller. Sally 
chooses Open customer session in OFN Teller and runs a customer search on John’s last 
name Walker. She then selects and opens the only account in the list, which is John’s 
checking account. 

Figure A-1   OFN teller application customer profile screen
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Sally pulls up information on John Walker’s account. The OFN customer profile view displays 
John’s user profile, including a photograph. Sally selects Withdrawal from the OFN Teller 
navigation view, and enters the total. Sally confirms the amount, clicks Done, and hands John 
the cash. 

John leaves, and Alice Sheen walks up to the teller and makes a deposit. Sally is already 
logged in to OFN Teller. Between the time John left and when Alice enters the branch, the 
leased line connection to the datacenter has gone down. The OFN network status indicator 
shows offline.

The Teller application is built on the access services provided with WebSphere Everyplace 
Deployment 6.0. When online, OFN uses a synchronous communication model that uses the 
JSR172 Web Services client for accessing customer and account information, and performing 
transactions.

Sally selects Open a customer session in OFN Teller. The search panel opens. Sally selects 
Account Number and searches for Alice’s account number 294311310536. The search finds 
there are two names on this account. Sally double-clicks on Alice Sheen to open the 
customer session.

OFN Teller pulls up information on Alice Sheen’s account. The OFN customer profile view 
displays Alice’s user profile without a photograph. In the offline scenario, OFN Teller uses 
cached customer records. The photograph is not displayed because the DB2® Sync Server 
administrator specified a policy that the photographs are not cached. 

The following WebSphere Everyplace Deployment 6.0 access services are used:

� DB2 Everyplace for caching the customer records and journal information locally on the 
client. In addition to DB2e, WebSphere Everyplace Deployment also provides Cloudscape™ 
as an alternative for developers that require greater functionality on the client.

� Mobile Services iSync for policy-based synchronization of account information for offline 
transactions. iSync can sync to both DB2e and Cloudscape.

Sally selects Deposit from the OFN Teller navigation view, and enters a total. Sally confirms 
the amount, clicks Done, and hands Alice a receipt. Alice walks out.

Sally looks at the journal and notes that the transaction is “pending.”

During the conversation, the network connection is reestablished. The OFN connectivity 
indicator turns green to indicate that the connection to the datacenter has been restored. 
Sally checks the journal and notes that the transaction result changes to “completed” within 
the journal.

In the offline scenario, OFN Teller stores the transactions locally. When the connection is 
restored, the transactions are sent to the back end in the correct sequence. This capability 
was built using the MQ Everyplace client, which is one of the access services provided with 
the WebSphere Everyplace Deployment 6.0 platform. This same asynchronous model could 
also be used when in online mode to increase responsiveness of the application. (For 
example, if the transaction takes a while to complete, the user can proceed with other tasks.)
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this book.

IBM Redbooks
For information about ordering these publications, see “How to get IBM Redbooks” on 
page 70. Note that some of the documents referenced here may be available in softcopy only. 

� Implementing IBM Director 5.10, SG24-6188

Other publications
These publications are also relevant as further information sources:

� IBM Director: http://www-03.ibm.com/systems/management/director/index.html 

Click Documentation and Resources in the navigator box on the left of the page.

– IBM Director v5.10
– IBM Director Compatibility v5.10 (45 KB)
– IBM Director Compatibility v5.10 Update 2 (250 KB)
– IBM Director Hardware and Software Support Guide v5.10 Update 3 (formly named the 

IBM Director Compatibility) (299 KB)
– IBM Director Release Notes v5.10 (348 KB)
– IBM Director Release Notes v5.10 Update 1 (470 KB)
– IBM Director Release Notes v5.10 Update 2 (459 KB)
– IBM Director Release Notes v5.10 Update 3 (739 KB)
– IBM Director Information Center
– IBM Director Systems Management Guide (8.96 MB)
– IBM Director Installation and Configuration Guide (6.30 MB)
– IBM Director Events Reference (4.62 MB)
– Upward Integration Modules Installation Guide (1.02 MB)
– IBM Director SNMP Support (250 KB)
– IBM Director and VMware
– IBM Director and Linux
– IBM Director User Forum

� Altiris: http://www.altirispro.com/Products/Altiris/index.html

– Deployment Solution 6.5 Reference Guide
– Deployment Solution 6.1 SP1
– PC Transplant 6.1 Product Guide
– PC Transplant Pro 4.0 Service Pack Release Notes
– RapidDeploy 6.1 Product Guide
– RapidDeploy 6.1 Release Notes
– RapidInstall 3.1 Release Documentation
– RapidInstall 3.1 User Guide

� ClearCube: http://www.clearcube.com

– Hosted Client Solutions with IBM BladeCenter and ClearCube Management Software
http://www.clearcube.com/downloads/english/IBM_CC_solution.pdf
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– Site Preparation for ClearCube Installation 

http://www.clearcube.com/support/controller/downloads.php?id=292 

– ClearCube Grid Center Admin Guide

http://www.clearcube.com/support/controller/downloads.php?id=260

– ClearCube I/Port

http://www.clearcube.com/controller/user_port.php

– I/Port Quick Reference Guide

http://www.clearcube.com/support/controller/downloads.php?id=264

– I/Port I8020/I8820 Quick Start Guide 

http://www.clearcube.com/support/controller/downloads.php?id=345

– I/Port I8020/I8820 Quick Start Guide 

http://www.clearcube.com/downloads/english/GridCenterDatasheet.pdf

� DataCom: http://www.datacomnvs.com

– Frequently Asked Questions 
http://www.datacomnvs.com/adobe%20files/Frequently%20Asked%20Questions.doc

– DataCom Systems Network Video Servers 
http://www.datacomnvs.com/adobe%20files/Product_Overview_VAR_1.0.pdf

Online resources
These Web sites are also relevant as further information sources:

� Windows Storage Server 
http://www.microsoft.com/windowsserversystem/wss2003/default.mspx

� Altiris Deployment Solution 

http://www.altiris.com/Products/DeploymentSolution.aspx

� VMware ESX

http://www.vmware.com/products/vi/esx/

� ClearCube Grid Center (now ClearCube Sentral) 
http://www.clearcube.com/controller/software.php

� IBM BladeCenter and BladeServers

http://www-03.ibm.com/systems/bladecenter

� Installing and configuring the DataCom Digital Surveillance solution

http://www.datacomvideo.com/index.html

How to get IBM Redbooks
You can search for, view, or download IBM Redbooks, Redpapers, Hints and Tips, draft 
publications and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at 
this Web site: 

ibm.com/redbooks
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Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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Environmental 
considerations

Solution details

Installation 
instructions

Systems Solution for Branch Banking is targeted to the financial 
institutions that have chosen to keep a decentralized infrastructure. 
This is approximately 50% of the customer base. This solution is a 
technology sell, and will therefore be most attractive to banks that are 
due for a technology refresh (that is, those that have not done a major 
upgrade of their branch infrastructure for the past 5 to 10 years). 

This IBM Redbook discusses how to install and configure the 
components of the Systems Solution for Branch Banking, a hardware 
and software solution that enables banks to provide a common, 
easy-to-support IT infrastructure in their branch locations. The solution 
takes into consideration that the skills required to upgrade or maintain 
the infrastructure in the branch does not exist, so we provide a remote 
management function. While a common solution has been defined, 
each implementation may have its own unique variations depending on 
the network, software, and hardware environments. 
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